Internet/Email

Converting Email
Address Books

Note: Though Academic Technology and Networks does not officially support address book conversions, this
document is provided as atool to the many members of the University population who will be, and have been,
changing email programs in recent months. The contents of this document will be regularly updated to keep up
with any changes, but general support, via the many other resources available through ATN, may not always be
available on address book conversions.

Introduction

This document provides directions on importing address books from one email program to another. If you use
more than one email program, or if you are in the process of changing email programs, you will probably want
to import your old address book into your new program. Thiswill save you the trouble of having to retype the
information for each entry into a new address book file. However, if you have arelatively short list of entriesin
your current address book, perhaps 25 or fewer, it would probably be easier to simply re-enter the names.

Address Book Basics

Address Books: An Address Book allows you to store email addresses so that you do not have to
remember the email addresses of people you writeto regularly. You can enter individual addressesin the
Address Book or you can organize your address book by groups. Address Books store such information as
first name, last name, nickname, and email address. Depending upon the program in which it is used, an
address book can store other information about each entry, like company affiliation and phone number.

Fields: Address books separate information about each entry into fields. Generally, each item of
information constitutes a separate field. For example, an entry in Pine would look like this when opened in
aword processing program:

kat hy Edwards, Kat hy kat hysue@nai | . com
In this example, the nickname, full name, and email address all represent individual fields.

Delimiters: Separating each field are keystrokes known as delimiters. Depending upon the program
being used, the delimiters could be commas, semi-colons or tab characters. In order to import an address
book from one IMAP client to another, the fields must contain the delimiters required by the email program
you will be using. In many cases, this means you will have to change the delimiters for the import to be
successful. In the above example, tabs serve as the delimiters between fields.

Global Replacement Function: Thisfunction allowsyou to replace one type of keystroke with
another. Thisis especially useful in replacing one type of delimiter with another in alengthy address book.
To perform this function in Word 97, highlight the Edit menu and select Replace. Inthe Find What
field, enter the keystroke you wish to replace (in the above example it would be~t for tab). Inthe
Replace with field, enter the new delimiter you wish to use. Select Replace All.

The Importing Procedure

The sections of this document are organized according to what program you are importing your address book
into. Each section begins with a general description of the formatting requirements for each of these programs,
followed by additional instructions for converting from specific email programs. Generally, though, each
conversion process follows the same basic steps. First you will open the address book file of the program you
wish to convert in aword processing program such as Word 97. Next, you will replace the old delimiters with
those required by the new program into which you are importing your address book. Finally, after saving the
edited addressbook asatext file, you will open the program into which you are converting your address book,
and follow the steps for importing.
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Note: Thefollowing directions should allow you to import single email address book entries rather easily, but
all of the email programs have difficulty importing group entries. Unless the new email program you will be
using alows you to import your old address book directly (for example, Mulberry allows you the option of
importing Pine directly), you will have to delete your group entries before importing your address book and re-
enter them in the new program.

Converting to Outlook Express

Before you can import an address book into Outlook Express, it must be in aformat that Outlook can read.
Outlook Expresswill only import atext file with fields separated by a comma delimiter. Outlook does not
require that the first and last names of each entry be separate fields. Y ou can make them separate fields, or keep
them as one field, aslong as you use commas as your delimiters. Each address book entry for Outlook Express
should appear in the following format:

j oseph, goehri ng, goehri ng@nail.comj oe

Note: You may add additional fieldsif you like, such as company or telephone number, but they too must be
separated by commeas.

Once you have edited your address book file so that it isin the proper format for Outlook to read (see directions
immediately following the numbered steps below), follow these steps to import it:

1. From Outlook Express, select the File menu, highlight I mport and from the drop down menu, select
Address Book.

2. Outlook Expresswill provide you with a selection of file types from which to import. Select the final
line, text file.

3. Select Browse and locate the old address book file you wish to import. Y ou must have saved thisfileasa
text file with the extension . csv, for comma separated values (For example, addr esses. csv) .
Highlight it and click Open.

4. Now the CSV
Import Window
will prompt you to
match fields from
your
addr esses. cs
v filewith
mleal(l.)al?tlligl(eldsm T 0] emailaddress
Express format. : O Joby
To match thefields 3]
properly, click the
checkbox next to
thefield name, and
then select the
appropriate
Outlook Express
field nameinthe
next window that
follows. Do this
until all thefields
inthe
addr esses. csv file have been matched with an Outlook Express field.
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5. Click Finish to begin theimport.

6. Toview and edit your imported address book select T ools and Addr ess Book from the Outlook Express
menul.

Before you follow the steps above, however, refer to the specific instructions below to find out how to edit your
old address book file so that it conforms to the proper formatting requirements.

From Pine (Telnet)

Pine' s address book iscalled . addr essbook and needs to be downloaded from your home directory on Isis
(thisisthe directory you are taken to after selecting option 8 from the Isis menu). See the document Win:
Telnet & FTP (iis07) for more information about downloading files.

After you have downloaded the address book file, open it in aword processing program such as Word 97. You
will see that Pine's address book separatesits fields using tabs rather than commas. An entry in a Pine address
book looks like this:

kat hy Edwards, Kathy kat hysue@nai |l . com

Consequently, you need to perform aglobal replacement function (see Address Book Basics at the top of
this document) that replaces the tab characters with commas. Y our edited version should look like the example
at the beginning of this section, although the fields do not have to be in the exact order.

From Siren

In order to edit your Siren address book in Word, you must first export it. To do this,
open Siren and highlight the Utility menu and select Address Book. Select
Command, then choose Export to ASCI1 file. Namethefile, and choose a
location in which to save it.

Open your Siren address book in aword processing program such asWord 97. The B
Siren address book file has fields that are separated by quotation marks and semi-colons. It WI|| Iook likethis:

"j oseph";"goehring";"";"";"goehring@nail.con';"joe
Doaglobal replacement function, replacing the quotation and semi-colon combinations (“;") with
commas. Then replace the quotation marks (*) that appear at the beginning and end of each line with nothing.

When you finish, each line should look like the example at the beginning of this section, although the fields do
not have to bein the exact order.

From Mulberry

The Mulberry address book is stored locally on your hard drive. If you have not changed the name and location
of your address book, it will be saved in your Mulberry folder under the name Addr ess. Open thisfilein
Word 97. Like Pine, Mulberry separates fields by tabs and includes the first and last names of each entry asa
singlefield. Each entry will look like this:

kat hy Edwards, Kathy kat hysue@nai |l . com

Again, perform aglobal replacement function that changes the tab charactersto commas. Y our edited
version should look like the example at the beginning of this section.
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From Outlook 98

Because Outlook Express and Outlook 98 share address books, there is no need to import your Outlook 98
address book into Outlook Express. If for some reason the address books do not share the same information, you
can make sure they do by opening your addr ess book in Outlook Express, going to the T ools menu,
highlighting Options and selecting Data Share. Make certain that Shar e contact infor mation option is
selected.

From Eudora

The Eudora address book, called nndbase. t xt, islocated in the Eudora Mail folder, which is stored locally
on your hard drive. If you have created new address books in Eudora, they will be saved astext filesin the
Nicknames folder, located in the Eudora Mail folder. The delimiters separating the fields in this case are single
spaces. An address book entry, when opened in aword processing program, will [ook like this:

Al'ias Joe goehring@nail.com

In order to import thisinto Siren, do aglobal replacement function that changes the single space
delimiters to commas. Then replace the word “dias’ with nothing. The entriesin your edited address book
should look like the sample entry at the top of this section. Now follow the numbered steps above to import
the address book into Outlook Express.

Note: Eudorais not supported by the IT Response Center.

From Netscape

From the Communicator menu, select M essenger. From the same menu, open your Addr ess Book and
then from the File menu, select Export. Select aname for your address book file and alocation in which you
wish to saveit. Theninthe Save as type box, select comma separated values. Now follow the
numbered steps above to import the address book into Outlook Express.

Converting to Outlook 98

Outlook 98 complicates the importing process with other IMAP clients, but it does import Outlook Express
address books easily. For thisreason, it is probably easier to import an address book into Outlook Express and
then import it into Outlook 98. If you do not already have it, download Outlook Express; it is packaged with
Internet Explorer 4.01. After you have imported your old address book into Outlook Express, see the
instructions above, follow these directions to import it into Outlook 98.

1. Fl'Om OUtIOOk 98 wleCt Import and Export Wizard
File...Import/Export. The I mport and
Export Wizard window will appear.

2. Sdlect Import Internet Mail and Addresses
and click Next. The Outlook Import Tool
window will appear.

3. Seect Outlook Express. Make surethat only
Import Address Book ischecked, and click
Next. The mport Addresses window will
appesar.

4. At theImport Addresses window you are presented vl o |
with some options; choose what is appropriate to el - =
you (probably Allow duplicates to be created) and click Finish.

5. You can review and edit your address book by opening the Contacts file.

Choose an action to perform:

Export ko a file

Export ko The Timex Data Link watch
Import a wCard File (vcf)

Import Internet Mail Account Settings

Impart & vCalendar file { ves
HImport Internet Mail and Addresses
Import from another program or file

~ Description
Imgort mail and addresses From Eudora Light and
P, Microsaft Internet Mail and Mews, Metscape
Mail and Messenger, and Outlook Express.

Cancel
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Converting to Mulberry

To import an address book into Mulberry, it must be in aformat that Mulberry can read. Mulberry will only
import atext file with fields separated by tabs. Each address book entry for Mulberry should appear in the
following format, with tabs as the delimiter:

joe joe goehring joe@nuail.com

Note: Youmay add additional fieldsif you like, but they too must be separated by tabs.

1. InMulberry, select Address Book manager fromthe

Addresses menu. Double-click on the L ocal folder, find your
L ) ; S e

address book, highlight it, qnd click Open. If you hqve pot Iﬁ | |@T|J o |

changed the name and location of your address book, it will be saved e e o

in your Mulberry folder under the name Addr ess. If you have not  [F]az] Name ;

yet created an address book in Mulberry, click the New button in EHSLocal

the upper right hand corner of theAddr ess Book M anager o4 LR A

Now that you have an
address book open, select
the Address menu, go to
Import Addresses, and
from the drop down menu I
select Pine.

Mulberry will prompt you
to open the appropriate file
to import. Find the folder
in which you have saved the address book file you wish to import,
and open that file.

The names from your old address book will now be added to your
Mulberry address book.

When you exit Mulberry, you will be asked if you wish to save
the changes you’ ve made to your address book. To save these
changes, you must select Y es.

Before you follow the steps above, however, refer to the specific instructions below to find out how to edit your
old address book file so that it conforms to the proper formatting requirements.

From Pine (Telnet)

Because Mulberry is able to import a Pine formatted address book directly, there is no need to edit your Pine
address book in aword processing program. Simply follow the steps above.

From Siren

In order to edit your Siren address book in Word, you must first export it. To do this, open Siren and highlight
the Utility menu and select Address Book. Select Command, then choose Export to ASCII file.
Name the file, and choose alocation in which to saveit.

Open your Siren address book in aword processing program such as Word 97. The Siren address book file has
fields that are separated by commas and semi-colons. It will look like this:
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"Joseph';''goehring';""" ;""" ;""goehring@email .com" ;" joe"

Doaglobal replacement function, replacing the quotation and semi-colon combinations (“;") with tabs.
Then replace the quotation marks () that appear at the beginning and end of each line with nothing. When you
finish, each line should look like the example at the beginning of this section. From Outlook Express

In order to open your Outlook Express address book in aword processing program you must first export it.

From the Outlook Express main menu, select the File menu, highlight Export, and from the drop down menu
select Address Book. Next, in the Export tool, select the line, text file (comma separated values).
Choose a name for thefile, such asoutlook.csv, and alocation in which to saveit. Click Finish. Your

address book file will then be saved as atext file.

Next, open the filein aword processing program. Using aglobal replacement function, replace the comma
delimiters with tabs. When you finish, each line should look like the example at the beginning of this section.

From Outlook 98

Address book files from Outlook 98 are difficult to import into other IMAP clients. For this reason you should
follow the above directions for importing an address book from Outlook Express. Because Outlook 98 shares an
address book with Outlook Express, the information in each address book will be identical, so nothing will
change if you import your address book from Outlook Express rather than from Outlook 98. If for some reason
the address books do not share the same information, you can make sure they do by opening your addr ess
book in Outlook Express, going to the T ool s menu, highlighting Options and selecting Data Share.
Make certain that Shar e contact information option is selected.

From Eudora

Just asin Pine, there is no need to change the delimitersin an Eudora address book when importing it into
Mulberry. Simply follow the numbered steps above, but instead of selecting Pine in step two, select Eudora
The Eudora address book, called nndbase.txt islocated in the Eudora Mail file, which is stored locally on your
hard drive. If you have created new address books in Eudora, they will be saved astext filesin the Nicknames
folder, located in the Eudora Mail folder.

Note: Eudorais not supported by the IT Response Center.

From Netscape

From the Communicator menu, select M essenger. From the same menu, open your Addr ess Book and
then from the File menu, select Export. Select aname for your address book file and alocation in which you
wish to saveit. Theninthe Save as type box, select tab separated values. Now follow the numbered
steps above to import the address book into Mulberry.

Converting to Siren

To import an address book into Siren, it must be in aformat that Siren can read. Siren will only import atext
file with fields separated by commas, semi-colons and several other characters. Siren also requiresthat the first
and last names of each entry be separate fields. Each address book entry for Siren should appear in the following
format, generally with commas or semi-colons as the delimiter:

kat hy; Edwar ds; Kat hy; kat hysue@mai | . com
Note: Youmay add additional fieldsif you like, but they too must be separated by commas or semi-colons.

Once you have edited your address book file so that it isin the proper format for Siren to read, follow these
steps to import it:
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1. InSiren Mail, open the address book utility by selecting Utility and then Addressbook. From the
Command menu choose Import from ASCII File. The Import window will appear.

2. Firgt, click onthe delimiter s drop down menu which appears in the upper right hand corner of the
window. Select a semi-colon or acommaas your delimiter, depending on which one you chose as your
delimiter when editing the filein Word.

3. Opentheaddress book file you wish to import by clicking on the button Select File to Import.

4. NeXtyOUWI”haVetO i - - o - o - e — - - - |
match the fields. Y ou will m
see adivided window; on . >
the |eft are the fields for the == iSeeliss ek
Siren address book, onthe  *
right will bethe fields
from your old address
book. Click on the
Select Fileto Import
button and find the file you

|Database Field ~{Import Order

First Mame
| Last Name
- | Compary Name

wish to import (for +{Fax Number
example, {Email Address
addresses.csv);you |Alias

may need to change the :

File Typeto All Files.
Then you need to match
these fields up so that they
arein the proper order--so
that the first name from
your old address book goes
into the First Name field
for Siren, etc. On the left side of the screen, click on the First Name field; on the right side, click on the line
which contains the first name for the entry. Then click on the <- button, and you will see the number of the
item on the right appear in the column on the left. Do thisfor each field. When you are done, click on the
Import button. You will be asked to choose which group to import the address book into; probably you should
just choose the Entire Group.

Before you follow the steps above, however, refer to the specific instructions below to find out how to edit your
old address book file so that it conforms to the proper formatting requirements.

From Pine

Pine’ s address book iscalled . addr essbook and needs to be downloaded from your home directory on Isis
(thisisthe directory you are taken to after selecting option 8 from the Isis menu). See the document Win:
Telnet & FTP (iis07) for more information about downloading files.

After you have downloaded the address book file, open it in aword processing program such as Word 97. You
will see that Pine's address book separates its fields using tabs rather than commas or semi-colons. In addition,
the first and last names in a Pine address book are separated by a comma and constitute asingle field, whereasin
Siren they need to be separate fields. An entry in aPine address book looks like this:

kat hy Edwards, Kathy kat hysue@nai |l . com

Consequently, you need to perform aglobal replacement function (see Address Book Basics at the top of
this document) that replaces the tab characters with semi-colons. Then replace the comma between the last and
first name with a semi-colon. Your edited version should look like the example at the beginning of this
section.
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From Mulberry

The Mulberry address book is stored locally on your hard drive. If you have not changed the name and location
of your address book, it will be saved in your Mulberry folder under the name Addr ess. Open thisfilein any
word processing program, such asWord 97. Like Pine, Mulberry separates fields by tabs and includes the first
and last names of each entry asasingle field. Each entry will ook like this:

j ohn Doe, John John@nuai |l . com

Again, perform aglobal replacement function that changes the tab charactersto semi-colons. Then
replace the commawith a semi-colon. Y our edited version should look like the example at the beginning of
this section.

From Outlook Express

An address book from Outlook Expressisrelatively easy to
import into Siren because it does not require you to replace
delimiters. From the Outlook Express main menu, select
the File menu, highlight Export, and from the drop down
menu select Addr ess Book. Next, in the Export tool,
select theling, text file (comma separated values).
Choose a name for the file, such asoutlook.csv, and a
location in which to saveit. Click Finish. Your address
book file will then be saved as atext file. You can now
follow the numbered steps above to import it into Siren,
just remember to make sure that in the Siren address book
tool you set the delimiter option to a comma.

From Outlook 98

Address book files from Outlook 98 are difficult to import into other IMAP clients. For this reason you should
follow the above directions for importing an address book from Outlook Express. Because Outlook 98 shares an
address book with Outlook Express, the information in each address book will be identical, so nothing will
change if you import your address book from Outlook Express rather than from Outlook 98. If for some reason
the address books do not share the same information, you can make sure they do by opening your addr ess
book in Outlook Express, going to the T ools menu, highlighting Options and selecting Data Share.
Make certain that Shar e contact information option is selected.

Adles DD Ellll TDI N N . ) [

From Eudora

The Eudora address book, called nndbase. t xt islocated in the Eudora Mail folder, which is stored locally on
your hard drive. If you have created new address books in Eudora, they will be saved astext filesin the
Nicknames folder, located in the Eudora Mail folder. The delimiters separating the fields in this case are single
spaces. An address book entry, when opened in aword processing program, will look like this:

Alias Joe goehring@nail.com

In order to import thisinto Siren, do aglobal replacement function that changes the single space
delimitersto commas. Then replace the word “alias’, and the single space after it, with nothing. The entriesin
your edited address book should look like the sample entry at the top of this section. Now follow the numbered
steps above to import the address book into Siren.

Note: Eudorais not supported by the IT Response Center.

From Netscape

From the Communicator menu, select M essenger. From the same menu, open your Addr ess Book and
then from the File menu, select Export. Select aname for your address book file and alocation in which you
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wish to saveit. Theninthe Save as type box, select comma separated values. Now follow the
numbered steps above to import the address book into Siren.

Warning: Siren address books are sometimes lost when your desktop computer freezes or the application crashes.
To ensure that you never completely lose your Siren address book, we advise that you create a back up of your
address book at least once per week usingthe Export to ASCI | file option. Thiswill create atext file of
your address book that you can refer back to if you address book islost at some point. (To use this option open
Address Book fromthe Utility and selectExport to ASCI I file from the Command menu.)

Converting To Eudora

According to the Eudora website, www.eudor a.com, Eudoraitself doesn't have a converter that will allow
you to import address books from other email programs. However, a shareware program, located at
http://www.inter guru.com/mailconv.htm, isavailable which will allow you to convert address books
from Pine and some Microsoft email servicesto Eudora. Note that the maintainer of the page would like a
twenty dollar payment for the service.

Converting to Netscape Mail

Before you can import an address book into Netscape Mail, it must be in aformat that Netscape can read.
Netscapeisableto import avariety of different address book formats, including Eudora, Outlook 97/98,
Outlook Express, and text files. Netscape will only import atext file with fields separated by a comma or atab
delimiter. If you areimporting atext file into Netscape mail, it should resemble the following entry, although
tabs could also be used as delimiters:

j oseph, goehri ng, goehri ng@nail.comj oe

Note: You may add additional fieldsif you like, such as company or telephone number, but they too must be
separated by commas or tabs.

Once you have edited your old address book file so that it isin the proper format for Netscape to read (see
directions immediately following the numbered steps bel ow), follow these steps to import it:

1. Fromthe Communicator menu, select M essenger. Then from the same menu, select Address
Book.

2. FromtheFile menu select Import. The Netscape Messenger Import Utility will appear and ask you to
select the import format you wish to use. You may choose from Eudora, LDIF File, Outlook
97/98, Outlook Express, or Text File. Select the proper format for the file you wish to import and
click on Next.
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3. After you have selected the proper format, you will be asked to locate the specific address book file you
wish to import. Enter the location into the Import File box.

4. Thereare two options here, depending on what kind
of fileyou areimporting. If you are importing a text
file, you will now have to enter the appropriate
delimiter inthe File Format box. From the drop
down menu, select either commas or tabs as your
delimiters Once you have done this, you will then
be asked to match up the fields so that they areinthe Flease select 3 Messenger address baok field for each value shown from the text
proper order -0 that the first name from your old e e o W on e g an aktss sk
address book goes into the First Name field for i _ I - ﬂ : '
Netscape, etc. Netscape will provide you with drop ;ommun|cator Field: Test values from Record 1T < _

down menus next to each field name from your old [ iMone) x| davejamison j -

address book file. Select the field name from the drop : )
down menu that matches the field name of the text to
the left of the menu. When you have finished, click
on Import and the entries from your old address
book will be added to your Netscape address book.

If you are importing afile other than atext file, such
asan Outlook Express address book, you must first | =~ et
enter its location, although Netscape may be able to %500na0aaasms00RREeaasnBERERscaaTao0E ot | cancel |

find it for you. You will then be asked which

“¢& Import Address Book

iamizon’

"dave"

-l :.':'

mailboxes you wish to import. If you wish to only
import your address book, select Skip. On the following screen, click on Finish and your old address
book will be imported into Netscape, usually as a new address book file. For example, if you imported
your Outlook Express address book, it will appear as a separate address book named Outlook Express.

From Pine

Pine' s address book iscalled . addr essbook and needs to be downloaded from your home directory on Isis
(thisisthe directory you are taken to after selecting option 8 from the Isis menu). See the document Win:
Telnet & FTP (iis 07) for more information about downloading files. Once you have downloaded your Pine
address book, follow steps 1-4 above, entering tabs as your delimiters.

From Mulberry

The Mulberry address book is stored locally on your hard drive. If you have not changed the name and location
of your address book, it will be saved in your Mulberry folder under the name Addr ess. To import this
address book into Netscape, follow steps 1-4 above, entering tabs as your delimiters. If you have problems,
make certain that the mulberry address book is saved as atext file with the extension . txt.

From Siren

In order to edit your Siren address book in Word, you must first export it. To do this, open Siren and highlight
the Utility menu and select Address Book. Select Command, then choose Export to ASCII file.
Name the file, and choose alocation in which to saveit.

Open your Siren address book in aword processing program such as Word 97. The Siren address book file has
fields that are separated by commas and semi-colons. It will look like this:

""Joseph;''goehring';""" ;""" ;""goehring@email .com" ;" joe"
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Doaglobal replacement function, replacing the quotation and semi-colon combinations (“;") with tabs.
Then replace the quotation marks (*) that appear at the beginning and end of each line with nothing. When you
finish, each line should look like the exampl e at the beginning of this section. Then follow steps 1-4 above,
selecting tabs as your delimiters.

From Outlook Express

Netscape allows you to import Outlook Express address books directly. Follow steps 1-4 above.
From Outlook 98

Netscape allows you to import Outlook 98 address books directly. Follow steps 1-4 above.
From Eudora

Netscape allows you to import Eudora address books directly. Follow steps 1-4 above.

Additional Resources

An additional resource for address book conversions can be found by pointing your web browser to

http://www.inter guru.com/mailconv.htm. This shareware program provides some useful toolsto help
you convert among clients such as Netscape, Eudora and Pine.
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Summary Table

Email Program

Delimiters Accepted

Field Names

Mulberry

Tab delimited only

Nickname, Full Name, Email, Company,
Phone Work, Phone Home, Fax, Address,
URLSs

Outlook Express

Comma delimited only

First Name, Last Name, Middle Name,
Nickname, Email Address, Home and
Work Address, and many other work-
related fields (Job Title, etc.)

Outlook 98 Comma delimited (much easier to import Same as Outlook Express
using Outlook Express, which shares an
address book with Outlook 98)
Siren Semicolon (;), back slash (/), front slash (V), First Name, Last Name, Company Name,

tilde (~), horizontal bar (]), and comma(,)

Fax Number, Email Address, Alias

Netscape 4.5

Comma or tab delimited text files, but also
imports Eudora, Outlook 97/98, and Outlook
Expressfiles.

First Name, Last Name, Email,
Nickname, Address, City, State, Zip,
Title, and many other work related fields
(Company, etc.)
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